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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

 

Intended Audience 

This User Guide is intended for the following audience: 

 Persons in charge of introducing automation devices. 

 Persons who design automation systems. 

 Persons who install or connect automation devices. 

 Persons who manage working automation installation. 

 

 

 

 

 

  Warnings: 

 Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

 Improper use of this product may severely damage the controller. 

 Refer to the controller’s User Guide regarding wiring considerations. 

 Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

 

 



 

Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

 Systems, machines, and equipment that could present a risk to life or property. 

 Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

 Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 

 



 

Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 

 

 

 

 

 



 

Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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 General Description GPRS / GSM CONTROLLER 54ARA I/Os 

PLUS 

 

 Zone - Nomenclature 

The nomenclature shown in this point will be used in the whole User Guide, so it is 

important to understand this nomenclature. 

The nomenclature to differentiate the zones is based on the Alphabet, being A the 

shield from below and D the shield from above. Having a B & C in the middle of them. It 

has 4 zones (A, B, C & D): 

 

 

 

 

 

 

 

 The inputs in the zone B are named I0.X, being X any number suitable in the 
Shield. Outputs are named as Q0.X and relays as R0.X 

 The inputs in the zone C are named I1.X, being X any number suitable in the 
Shield. Digital Outputs are named as Q1.X and Analog Outputs as A1.X. 

 The inputs in the zone D are named I2.X, being X any number suitable in the 
Shield. Outputs are named as Q2.X and relays as R2.X 
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 Zone Distribution 

 

 A Zone Features 

Shield A Zone 

 
 
 
 
 

Communication 
Shield 

(1x) Ethernet 
(1x) USB 
(1x) I2C 
(3x) TTL 
(1x) RS-232 
(1x) HALF/FULL Duplex RS-485 
(1x) SPI external Port 
(1x) RTC 
(1x) uSD Socket 
(1x) GPRS/GSM  
 

 

 Mechanical dimension 

 

 

2.  



 

 

 General Features  

CONECTABLE PLC ARDUINO 24Vcc M-DUINO 

MODEL TYPE              GPRS/GSM Controller General Spec.  

Input Voltage 12 to 24Vdc 
Fuse protection (2.5A) 

Polarity protection 
 

I max. 1.5A  

Size 101x119.5x70.1 101x119.5x119.3 

Clock Speed 16MHz  

Flash Memory 256KB of which 8KB used by bootloader  

SRAM 8KB  

EEPROM 4KB  

Communications 
I2C  –  Ethernet Port – USB –  GPRS –  RS485 – RS232 -- SPI – 

(2x) Rx, Tx (Arduino pins) 
Max232-Max485-W5500-

Sim800L 

USB consideration! 
Only meant for uploading or debugging, not always connected 

as a serial in a project! 
Cannot be working in a final 

application 

An/Dig Input 10bit 
(0-10Vcc) 

0 to 10V 
Input Impedance: 39K 
Separated PCB ground 

 

Digital Isolated Input (24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

* Interrupt isolated Input HS 
(24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vdc  
I max: 20 mA 

Separated PCB ground 
 

 

Digital Isolated Output (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

Imax 24Vdc: 410 mA 

Digital Isolated Output Relay 

220V Vac 
I max: 5A 

Galvanic Isolation 
Diode protected for Relay 

 

PWM Isolated Output 8bit 
(24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

 

Relay Output 
I max: 5A 

V max: 24VDC / 230VAC 
 

Expandability I2C - 127 elements   -  Serial Port RS232/RS485/GPRS  

* By using this type of signal can no longer use Digital signal (24Vdc)   

 



 

 Technical Specifications: 

 General Specifications: 

Item M-DUINO B ZONE 

Power supply 
voltage 

DC power supply 12 to 24Vdc 

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply 
voltage 

24Vdc 

Power supply 
output capacity 

700Ma 

Insulation resistance 20MΩ min.at 500Vdc between the AC terminals and the protective earth terminal. 

Dielectric strength 
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the 
external AC terminals and the protective ground terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 45ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 861g max. 

 
 

 Performance Specification: 

Arduino Board ARDUINO MEGA 2560 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a 
programming language. “similar to the C”.  http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega2560 

Flash Memory 256KB of which 8KB are used by the bootloader 

Program capacity (SRAM) 8KB 

EEPROM 4KB 

Clock Speed 16MHz 

Clock Speed 16MHz 

 



 

 Precautions 

Read this manual before attempting to use the GPRS/GSM 54ARA I/Os PLUS PLC and follow its 

descriptions for reference during operation. 

 Arduino Board 

The GPRS/GSM Controller includes an Arduino Mega Board as controller.  

 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 

The user must operate M-Duino according to the performance specifications described in this 

manual. 

Before using the GPRS/GSM Controller under different conditions from what has been specified 

in this manual or integrating GPRS/GSM Controller to nuclear control systems, railroad systems, 

aviation systems, vehicles, combustion systems, medical equipment, amusement machines, 

safety equipment and other systems, machines, and equipment that may have a serious 

influence on lives and property if used improperly, consult your INDUSTRIAL SHIELDS 

representative. Ensure that the rating and performance characteristics of GPRS/GSM Controller 

are sufficient for the systems, machines, and equipment, and be sure to provide the systems, 

machines, and equipment double safety mechanisms. This manual provides information for 

programming and operating the GPRS/GSM 54ARA I/Os PLUS Controller.  

 

 Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no 

needed to define the pins and if that pins are inputs or outputs. Everything is set up 

automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 

 

 



 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager 

 

 

 



 

5. Search for “industrialshields” on the browser. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following these steps you will be able to see now the Industrial Shields Boards: 

 

 

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 



 

In this case, the GPRS/GSM Controller uses the MDuino 54ARA + model, as you can see in the 

following image: 

 

 

 

Also there are some examples of programming in File -> Examples -> M-Duino Family. 

Furthermore there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

 

 

 

 

 



 

 How to connect PLC Arduino to PC 

- Connect USB port from PLC to PC.  

NOTE:  
M-Duino Family uses USB-B cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> M-Duino Family 
 
 
 

- Select the correct M-Duino Board (M-Duino 54ARA+). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Select correct port. 

 

 

 

 

 

 

 

 

 

 



 

 How to connect PLC to power supply 

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 

 

  

- Suggested power suppliers

  

 

 

 

 

 

 

 

 

 

 

 

* Not recommended for industrial applications. The 

Jack connector needs to be removed and use the live 

and GND connectors.   



 

 M-duino Family Pinout 

 A Zone connection 

 

 

 

 

 

 

 

 

 

 

 

 

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device. 
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SCL 
SDA 
RX0 
TX0 
RX1* 
TX1* 
TX 
RX 
Z- 
Y+ 
B- 
A+ 

PIN3 
50 SO 
51 SI 

52 SCK 
Reset 
Vin5 
NC 

GND 
GND 

24Vdc 

21 
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1 
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NC 
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TX0/SS 
RX1/SS 
TX1/SS 

RX2(serial 2) 
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Arduino Pin 
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SPI 
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7Vdc 
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3.3Vdc 
GND 
5Vdc 

GND 

Arduino PIN 
Arduino PIN 
Arduino PIN 

- 
GND 

Arduino PIN 
GND 

- 
GND 

 
 
 
Configuration Switch* (see section 8 for 
configuring the communications. 
Enabling communications disables some 
I/Os) 
 
 
Rx1/Tx1 * Pins used for the GPRS module 
 
Communication Pins 
 
 
 
 
 
 
 
 
Power supply connectors  
(24Vdc – GND) 

                                                      

 



 

 

 

 

 

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using 

serial communication. When uploading code to Arduino Mega set switch to ON.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ethernet            Arduino                                               Power 
Connector         Reset button        
                                                            USB programmer                         Autoreset 
          connector   

   



 

 B Zone (Analog Shield) 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 Relay Shield 

   

                                                           
1 See section 8 to select suitable switch configuration for enable these connections. 
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I0.12 
I0.11 
I0.10 
I0.9 
I0.8 
I0.7 

(-)I0.6/INT1 
I0.6/INT11 

NC 
NC 
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I0.2 

(-)I0.1 
I0.1 

(-)I0.0 
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Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I0.6 
Interrupt 1 In 

Not Connected 
Not Connected 

GND I0.4 
Digital Input 
GND I0.3 

Digital Input 
GND I0.2 

Digital Input 
GND I0.1 

Digital Input 
GND I0.0 

Digital Input 
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GND 
A0.71 
A0.61 
A0.51 
Q/Vdc 
COM(-) 
Q0.71 
Q0.61 
Q0.51 
Q0.4 
Q0.3 
Q0.2 
Q0.1 
Q0.0 

GND 
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5  
4  
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6 
5 
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GND 
Analog Out 
Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

Led indicator I/Os state 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference  for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Top Zone 



 

 C Zone (Relay Shield) 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 
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Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I0.1 

Interrupt 0 In 
GND I0.0 

 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
Analog Output (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
 

 

. 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
Configuration Switch*  
(see section 8 to select correct 
configuration for outputs). 
 

Top Zone 

Led indicator I/Os state 



 

 D Zone (Analog Shield) 

 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 
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Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
 
 
Configuration Switch*  
(see section 8 to select the  correct 
configuration for outputs). 
 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 



 

  Switch Configuration 

 

 A Zone: Communications  

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

4. SCL/I2.6: Choosing between SCL or the input I2.6. If this switch is ON, it enables the I2.6    

input and disables the SCL. If this switch is OFF, it enables SCL and disables I2.6.  

3. SDA/I2.5: Choosing between SDA or the input I2.5. If this switch is ON, it enables the I2.5    

input and disables the SDA. If this switch is OFF, it enables SDA and disables I2.5.  

2. RX1/I1.1: Choosing between RX1 or the input I1.1. If this switch is ON, it enables the I1.6 

input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.1.  

1. TX1/I1.0: Choosing between TX1 or the input I1.0. If this switch is ON, it enables the I1.0 

input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.0..  

 

LEFT ZONE 

Switch Analog Shield 

 ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 

C ZONE 

RX1/I1.1 I1.1 RX1 

TX1/I1.0 I1.0 TX1 

B ZONE 

Pin 3/I0.6 I0.6 Pin 3 

Pin 2/I0.5 I0.5 Pin 2 

uSD & RS-485 

D53(SD) Q2.0 SD 

FD RS-485 HD HD FD 



 

 
 
 

4. Pin 3/I0.6:  Choosing between Pin 3 or the input I0.6. If this switch is ON, it enables the I0.6 
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables I0.6. 
 
3. Pin 2/I0.5:  ALWAYS AT OFF POSITION. Pin 2 and I0.5 Are used by the Sim800L module (The 
GPRS/GSM Module). DON’T USE I0.5 and Pin 2! 
 
2. D53(SD):  If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

 
1. FD RS-485 HD:  Choosing between FD or HF. If this switch is ON, it enables the Half Duplex 
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and  
disables HD 

 

 

 

 

 

 

 

 

1. RTC SDA: This switch enables the communication to communicate with the RTC using 

I2C. Having this switch in ON mode it actives this communication, whereas if it is in 

OFF mode it disables the I2C to reach the RTC.  

 

2. RTC SCL: This switch enables the communication to communicate with the RTC using 

I2C. Having this switch in ON mode it actives this communication, whereas if it is in 

OFF mode it disables the I2C to reach the RTC.  

 

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in 

ON mode or OFF mode. 

 

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in 

ON mode or OFF mode. 

 

 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 



 

 Analog and Relay Shields 

 

 

 

 

 

                     

 

 

 

 

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF 

it can only act as an Analog Output.   

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with Q0.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with A0.X, being X any number of the tables above.   

  

 

 

 

 

 

 

 

 

 

 

B ZONE 

SWITCH ON OFF 

NC - - 

Q0.7 Q0.7 A0.7 

Q0.6 Q0.6 A0.6 

Q0.5 Q0.5 A0.5 

C ZONE 

SWITCH ON OFF 

NC - - 

Q1.2 Q1.2 A1.2 

Q1.1 Q1.1 A1.1 

Q1.0 Q1.0 A1.0 

D ZONE 

SWITCH ON OFF 

NC - - 

Q2.7 Q2.7 A2.7 

Q2.6 Q2.6 A2.6 

Q2.5 Q2.5 A2.5 



 

 GPRS/GPS  I/Os 5V pins 

The GPRS/GSM Controller has some of the Mega board pins available.  These pins can be 

programmed according to Arduino features such as I/Os operating at 5V or any additional 

features present in the pins (for example I2C communication in pins SCL and SDA). As this pins 

are directly connected to the Arduino Mega board they are not as well protect as the normal 

inputs. These pins are mainly meant to be used as prototyping. 

The Arduino board available pins are summarized in the table below. In order to access some 

of these pins the configuration switch must be set to OFF position (see section 8) and some 

extra considerations must be taken in consideration when using these pins. 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Mega board. 

A part from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

 I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case 

it reads 5V when nothing is connected. The pull-up configuration is stablished by default in 

these pins. 

 If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up 

inputs. 

*IMPORTANT: I2.5 & I2.6 are not pull-up inputs although they are referred to the I2C pins 

(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the 

same behaviour as the other inputs.  

 Serial 0 – RX0/TX0 

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in 

case that all the 5V pins are already performing a function. This is because they are shared 

with the USB interface. If using these pins, the USB communication cannot be working at the 

same time. When the PLC is not installed, the USB communication is normally required for 

M-Duino terminal Arduino pin Enable Arduino pin 

SCL 21 Communication switch: OFF 

SDA 20 Communication switch OFF 

RX0 0  

TX0 1  

RX1 19 Communication switch: OFF 

TX1 18 Communication switch: OFF 

MISO 50  

MOSI 51  

SCK 52  

Pin 3 3 Communication switch: OFF 



 

debugging, uploading and intercommunicating with the Ethernet controller. If using both 

interfaces at the same time the Arduino board will get blocked.  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Serial 1 – RX1/TX1 

In the GPRS/GSM Controller, Serial 1 is used to communicate through the Sim800L integrated 

GPRS/GSM Module. If you want to use Serial 1 instead of GPRS/GSM, you must set the Pin 2 

(Pin used as the GPRS/GSM) always at high position. 

 

Remember: if you use the Serial1 in your program, you will not be able to use the GPRS / GSM 

functionalities! 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 SPI – MISO/MOSI/SCK 

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours 

cannot happen at the same time as the Ethernet would not work. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Pin 3 

This pin is only referred to the inputs I0.1. If the switch configuration is in OFF position the pin 

Pin 3 will be available. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 



 

 Pin 2  

 

REMEMBER THAT PIN2 IS USED BY THE SIM800L MODULE AS RESET PIN, SO IS NOT 

AVAILABLE IN THE GPRS/GSM CONTROLLER! 

IF YOU WANT TO USE SERIAL1, YOU MUST SET THE PIN2 ALWAYS AT HIGH POSITION. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 A Zone Features: Communications & RTC & uSD 

 RS-232 

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16 

and 17 of the Arduino Mega).  

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not 

matter the configuration of the switches to implement a RS-232 communication. 

Using the boards of Industrial Shields, there is a library that simplifies the RS-232 

implementation. 

  

 RS-485 

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart 

below.  

Function Arduino Pin 

DI 14 

RO 15 

RE 11 

DE 46 

 

For the RS-485 communication protocol there is only one switch that affects in this 

communication. The RS-485 protocol will be always enabled, the only switch that affects is the 

one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485 

Half Duplex or RS-485 Full Duplex (RS-422). 

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 

 

 

 

 

 

 

 

 

 



 

 I2C 

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino Family. The pull-up 

resistor is already implemented in the PCB.  

I2C communication is configured by switches, so the switches must be configured in order to 

enable the I2C communication. 

 

 

 

 

To enable I2C the switches SCL/I2.6(I2.1) & SDA/I2.5(I2.0) must be set to OFF mode. In this 

mode the inputs are totally disabled and the I2C is now enabled. 

Industrial Shields does not provide any library to implement the I2C as it can be used the 

standard library of Arduino called Wire. 

 

 SPI 

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO, 

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely, 

each of the connected devices will have a single and dedicated SS pin.  

Function M-Duino connection Mega board pin 

MISO 50 S0 50 

MOSI 51 SI 51 

CLOCK 52 SCK 52 

Reset Reset Reset 

SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3 

Check the switch configuration at section 8 to enable SS pins. 

 

 

 TTL 

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTL0 is accessed with the function Serial (pins 0 

and 1 of the Arduino Mega). TTL1 is accessed with the function Serial1 (pins 18 and 19 of the 

Arduino Mega).  

In order to use the TTL pins the configuration of the switches have to be the following one: 

 

Switch Analog Shield 

 ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 



 

 

 

 

 

If the switches RX1/I1.6(I1.1) & TX1/I1.5(I1.0) are in OFF mode, the RX1/TX1 will be enabled. In 

order to use TTL3 these switches must be in OFF mode. 

 Ethernet 

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible 

with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible 

with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS 

Arduino Mega pin 10).  

 

 RTC 

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol 

communication, so it is required to have enabled the I2C protocol.  

4 switches have to be configured in order to enable the RTC features: 

 

RTC SCL & RTC SDA must be set to ON mode to 

enable the I2C wires to the RTC. If they are in OFF 

mode, the Arduino won’t communicate with the RTC. 

 

 

I2C must be enabled in order to communicate with 

the RTC. See section 11 I2C to enable it. 

 

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC. 

 

 

 

 

Switch Relay Shield 

 ON OFF 

C ZONE 

RX1/I1.6 I1.1 RX1 

TX1/I1.5 I1.0 TX1 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 

Switch Analog Shield 

 ON OFF 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 



 

 uSD 

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol 

is always enabled, as there are no switches that configure it. However, there is a switch that 

must be placed to ON mode in order to communicate with the uSD: 

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket. If this switch is 

ON, it does not enable any pin, so you must putt he switch always at OFF position! 

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of 

the PLC, it is required to open the plastic found in the frontal part and the socket is located 

under the supply of the Arduino. 

 

 

 

 

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation 

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to 

select the Chip Select of the uSD chip. 

 

 GPRS/GSM  

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC and to 

program it you must download this library on your Arduino IDE. 

You can test the GPRS / GSM functionality using the examples that come with the library: 

LEFT ZONE 

Switch Analog Shield 

 ON OFF 

uSD  

D53(SD) Q2.0 D53(SD) 



 

 

When defining the pins in the program, take into account that the internal connections 

between the Sim800l module and the Arduino Mega are the following: 

 

 

Arduino Mega Pinout Sim800L Pinout 

5Vdc Vcc 

GND GND 

Tx1 (Pin 18) TxD 

Rx1 (Pin19) RxD 

Pin 2 RST 

 

 

How to define it in a sketch: 

#define FONA_RX 19 //RX1 on Arduino Mega 

#define FONA_TX 18 //TX1 on Arduino Mega 

#define FONA_RST 2 

 



 

The GPRS/GSM protocol is always enabled as there are no switches that configure it.  

the GPRS / GSM protocol uses the Serial1 of the equipment to be able to communicate and the 

pin2 for the module reset. 

If you want to use Serial1, you must indicate in the program that pin2 is always in High 

position. In case of using the Serial1, the GPRS / GSM communication can not be used. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 I/O technical details:  

 

Digital Output Waveform: 

 

 

 

 

 

 

 

Digital Out-put Turn-off: 

 

PWM Waveform:  

 

 



 

Analog Out Turn On: 

 

Analog Out Turn-Off: 

 

Analog /Digital input Turn-on: 

 

 

 

 

 



 

 Typical Connections 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 Connector details: 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 



 

 

 Mechanical Characteristics 

 

- Dimension GPRS/GSM Controller: 

 

 

 

 
 

- DIN Rail mounting 
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Zip/Postal Code: 08272  
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Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 
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